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Objectives 

 1. Define the concepts of information and computer literacy.
 2. Review the organization of this text.
 3. Identify elements of a computer lab system.
 4. Identify the hardware and software components needed for email  

communication. 
 5. Log in to a computer system. 
 6. Send email messages.
 7. Download and upload an email attachment.
 8. Identify and prevent security threats when using email. 
 9. Create a PDF file.
 10. Compress and unzip a file.
 11. Use a few basic features in OneNote.

Introduction
Healthcare professionals increasingly rely on information systems to assist 
them in providing quality care. They realize that a large percentage of their 
practice involves the management of information. Computers are often 
required to perform information-related functions such as identifying 
patient needs; documenting care; providing remote patient care through 
telemedicine facilities; organizing, calculating, and managing financial data; 
and accessing healthcare literature. To use the tools of automation in meeting 
their responsibilities and to take advantage of evolving computer technolo-
gies, healthcare professionals must be computer and information literate.
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The purpose of this text is to help you develop the essential computer and 
information literacy skills that all healthcare professionals need. Its focus is the 
introduction of concepts that cross specific applications, the development of prac-
tical computer skills, the access and use of information to provide quality patient 
care, and the development of electronic communication skills. Each chapter pro-
vides exercises from the healthcare arena that demonstrates the concepts and 
skills and provides practice in applying those concepts and skills.

Literacy
Healthcare providers learn to use the tools necessary to provide patient care such 
as a stethoscope to assess patients and a pulse oximeter to measure a patient’s 
pulse and oxygen saturation. This practice involves understanding the function 
and purpose of the stethoscope and pulse oximeter as well as developing skill in 
using them. Just as healthcare providers learn to use the right tools, so they must 
also learn the function and purpose of computers and software in health care 
as well as develop skill in their use. In other words, healthcare providers must 
become “computer and information literate.”

Literacy

Literacy means the ability to locate and use printed and written information to 
make decisions and to function in society, both personally and professionally.

Computer Literacy

Add “computer” to the term “literacy,” and it refers to the ability to use the com-
puter to do practical tasks. A variety of viewpoints exist that identify computer 
skills required for computer literacy, but there is general agreement that computer 
literacy includes the ability to use basic computer applications to complete tasks.

Information Literacy

This term describes a set of skills that enables a person to identify an informa-
tion need, locate and access the required information, evaluate the information 
found, and communicate and use that information effectively. With the explosion 
of information, both good and bad, information literacy has taken on a major role 
in all educational settings.

Digital Literacy

Digital literacy is the ability to effectively and critically use digital technology to 
navigate, evaluate, and create information. It includes the ability to understand 
and use information that is presented in multiple formats.
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People who are computer, information, and digital literate have the following 
characteristics. They:

■■ Use the computer, appropriate digital technologies, and associated software 
as tools to complete their work in a more effective and efficient manner.

■■ Recognize the need for accurate and complete information as the basis for 
intelligent decision making.

■■ Find appropriate sources of information using successful search strategies.
■■ Evaluate and manage information to facilitate their work.
■■ Communicate information in various formats.
■■ Integrate technology and information strategies into their daily professional 
lives.

Many professional organizations and accrediting agencies now include infor-
mation and computer literacy requirements as part of their criteria. For example, 
the Association of College and Research Libraries (ACRL) produced a document 
defining and outlining specific criteria and standards for demonstrating informa-
tion literacy in higher education (Association of College and Research Libraries, 
2000). To support the development of information literacy, they developed a Web 
site with links and citations to information literacy standards and curricula devel-
oped by accrediting agencies, professional associations, and institutions of higher 
education. You can view the ACRL Web site at http://www.ala.org/acrl/standards 
/informationliteracycompetency. Chapter 12 provides additional information on 
the concept of literacy.

Organization of the Text
This text consists of 14 chapters and an index that features highlighted com-
puter terms. Most chapters begin with information that introduces the content, 
describes key concepts and terms, and, in application chapters, provides descrip-
tions of common application functions and keystrokes. Each chapter also includes 
one or more exercises for use in the classroom or computer laboratory to practice 
application of lesson concepts and one or more assignments to demonstrate your 
knowledge and acquired skills. Additional materials for exercises and assignments 
are available to download from the text’s Web site.

The first chapter provides material that is useful to understanding and using 
this text as well as an introduction to email and OneNote. Chapters 2, 3, and 4 
contain content about hardware and software. Computer hardware and software 
terms are introduced in Chapter 2. Chapter 3 focuses on managing the com-
puter environment. Chapter 4 covers tasks that are common to most application 
programs. As a consequence of this consistency, many applications in a graphic 
environment have common looks and functions. The next four chapters present 
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word processing (Word), presentation graphics (PowerPoint), spreadsheet (Excel) 
and database applications (Excel database features). Including database func-
tionality within spreadsheet application. We use Microsoft Office applications to 
illustrate the basic concepts of each of these chapters. The text then introduces 
basic Internet concepts for connecting and browsing, and related software such 
as Internet Explorer and Chrome. Chapters 9, 10, and 11 share tips for successful 
communication over the Internet and in distance education endeavors. Chapters 
12 and 13 review means of accessing informational resources and issues of secu-
rity, integrity, and ethical use of electronic data. Chapter 14 provides an introduc-
tion to the field of healthcare informatics.

The authors have made every attempt to select current quality Internet sites 
that demonstrate the presented concepts. Remember, however, that Internet sites 
can and do change, so some of the links may not work. You may have to practice 
your searching skills to find a similar site.

Before Beginning: Some helpful Information
Every computer system and every computer laboratory have subtle differences 
that can cause problems for the beginner; therefore, learning something about 
the computer environment in use is essential. Professors or computer laboratory 
personnel as well as university documentation can help to answer questions about 
the following topics.

Accounts

Is an account necessary to use the computer laboratory or university’s resources? 
If so, what is the process for getting one? Some schools have at least a 24-hour wait 
time before you can use the laboratories. By comparison, other schools automati-
cally create an account when a student registers or provide facilities and direc-
tions to create an instant account. Some schools require students to own laptops 
or mobile devices, but you will still need an account to sign on to the school’s net-
work. A separate account may also be necessary to access course materials made 
available through the Internet or that reside on course management software 
servers. Other schools provide for one login option that provides access to all the 
resources to which a student may be entitled.

Cost

Is there a user charge for accessing and using the university computer equip-
ment and software? Do the rates vary (less at night or during off-peak times)? Is a 
computer fee included in tuition charges? What does the fee cover? For example, 
there may be an additional fee for computer equipment and/or applications with 
selected courses.
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Documentation

Most universities provide user documentation.   This includes user documenta-
tion that provides helpful information for starting and learning specific software 
programs.  Where is the documentation? Are handouts available in the computer 
laboratory, and/or are the documents available online to read and/or print? Which 
documentation is necessary to begin? For example, the university  might have a 
document called “Getting Started with Outlook” or “Accessing the Network from 
Home”, or “Accessing the University Resources with a Mobile Device”.

Computer Laboratories

Are there computer laboratories and who has access to them? Is an identification 
card required to use the equipment and software? Are some laboratories reserved 
for specific student populations—for example, health professional students or 
engineering students—or are all laboratories general-purpose facilities that are 
available to all students, staff, and faculty?

Equipment/Mobile Devices/Storage

Which type of hardware is available? Are the computers always left on? If not, how 
do you turn them on? Can I bring my own laptop or mobile device to the computer 
labs and connect to the network? Is it wireless or wired? What are the requirements 
for connecting your laptop or mobile device to the network while on campus? 
Where can students store data files? Do I automatically have storage space on the 
network? If so, how much? Which types of storage devices can I use and where can 
I purchase them? Does the bookstore sell removable storage devices?

Laboratory Hours

What are the laboratory hours? Do they change during the term? Is the labora-
tory open over the weekend? Some laboratories expand their hours of operation 
toward the end of the term when many papers and projects are due. Does a labo-
ratory assistant need to be present for the laboratory to be open, or is the labora-
tory left unattended? If so do I need an ID to enter a closed lab?

Lease or Buy

Does the university have a program whereby students lease or buy a laptop com-
puter or mobile device for use at home, in the dormitory, or in the classroom? If 
so, how long does it take to get a computer? How does the university support this 
program in terms of repair, software, and other technical issues? Is there a protec-
tion plan offered? Can you buy the computer or mobile device at the end of the 
lease? Is a certain operating system (i.e., Windows or Mac) required?

Before Beginning: Some Helpful Information 5
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Logging In

Most resources that you will need as a student and as a professional will require 
you to log in to the system. Some institutions have a universal login that provides 
a customized home page (referred to as a portal) with all your resources a click 
away; other institutions require separate accounts for  each resource like the net-
work, email, library online databases, student records, course management soft-
ware, patient clinical records, drug administration systems, and so forth. Is there a 
login procedure (a series of steps to access the computer software)? If so, how do 
you log into the system? Is there a help sheet to follow?

Policies/Rules

What are the policies that govern use of the  university resources? Policies can 
include anything from how often to change a password to how many pages one 
can print each term to respecting the rights of other users. What are the penal-
ties for not adhering to the policies? Penalties might range from a warning for 
a minor offense to dismissal or expulsion for a major offense. Most universities 
as well as other  organizations and businesses provide  policies to each account 
holder. For example, most institutions will address confidentiality of data and 
protection of a password in the policies. Individuals who hold dual roles such as a 
student employee may need to may need to follow policies for both roles.  

In addition there may be rules or policies that apply to certain areas or applica-
tions. For example, what are the rules that govern use of the computer laborato-
ries? Many laboratories prohibit eating and drinking, chatting, and game playing. 
Laboratories can restrict use to academic use only. Some laboratories also check 
all removable storage devices that one brings into the laboratory for viruses. What 
are the rules for policies devices?

Printing

Which printing capabilities are available at the university? Can you print to college 
printers with your mobile device? Is there access to color printing? Is there a charge 
for printing? Some schools use a prepaid print card, keep an electronic record of 
printing that allows individual billing, or use a software program such as PaperCut 
to keep track of printing costs. When the printing credits go to zero, the student must 
add more print credits to continue printing. Other schools permit unlimited printing.

Support/Help

What kind of support is available when one needs help? Many universities provide 
a help desk to assist students, faculty and staff who have questions or are experi-
encing problems. In addition there are often  online help services and quick reference 
guides.  Are there orientation classes for the laboratories and/or training classes on 
specific software?  Key questions in accessing these resources include (1) What is the 
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telephone number for the help desk? (2) What is its email address? (3) What are the 
hours or live support? (4) What automated services are available for support?

Getting Started With Your Computer
It is wise to review the material in this section before beginning work on a 
computer.

Enter Throughout this text, Enter refers to the Enter or 
return key. When the word “Enter” appears in this text, 
do not type it. Instead, press the Enter or return key 
with a left-pointing  ( )  arrow.

Bold Instructions in bold indicate what to click on, which 
keys to press, or what to type. Computers are very 
exacting. A misspelled word or failure to place a blank 
where a blank is required may result in an error mes-
sage. When instructions indicate to type, make sure 
you type exactly what is in bold.

Ctrl+X When Ctrl (or Alt or Shift) appears with a plus sign 
(+) and function key number or letter, press the first 
key and then, while holding it down, press the correct 
function or letter key. Release both keys together. On 
a Mac computer the Command key, next to the space 
bar, works like the Ctrl key on a Windows computer.

Version The specific sequence and location of commands vary 
with different versions of software. In this text, we use 
Microsoft Office 2010 for the word processing, pre-
sentation graphics, spreadsheet, and database content, 
and Internet Explorer (version 9) and Chrome (version 
25.0.1364.97) for the two browsers. If your computer is 
a Mac with Office 2011 or Safari (browser), some of the 
specific commands will be different.

Windows/Mac OS Although the exercises for Word, Excel, PowerPoint, 
Internet Explorer, and Chrome are intended for Windows 
7 users, you can just as easily use Mac-based programs 
for these exercises. Most of the keystrokes are exactly the 
same. A few menu items and a few keys on the keyboard 
are different. Although we made every attempt to repli-
cate the windows in true form, your system may display 
some variations in terms of how the window “looks.” 
Despite these minor differences, you should be able to 
follow along in the exercises.

Getting Started With Your Computer 7
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Developing a Few Basic Skills
This section covers concepts and skills of logging in, working with PDF files, and 
compressing/extracting zip files/folders.

Logging In

To log in:

1. From off campus, you may be required to type in an address in a browser 
like intranet.laroche.edu to access the main internal Web page, pressing 
Ctrl+Alt+Delete to access the login screen, or opening an icon on the 
desktop for a specific system. Figure 1-1 provides two examples.

2. Type your UserID or user name in the appropriate textbox.
3. Type your password in the appropriate text box. NOTE: The password will 

not show but will have asterisks or black dots in place of the typed letters 
and numbers. Some system passwords are case sensitive.

Working with PDF Files

Working in the computer environment requires some knowledge of working with 
files that you might need for a class or that you might need to send to your pro-
fessor. Many professors use PDF (portable document format) files as they are files 

Figure 1-1 Two Login Examples

NOTE: Some systems you access may have specific settings required for them to function 
properly. For example, Blackboard requires you to enable JavaScript and cookies while 
Microsoft’s Web-based access to Outlook requires you to enable popups. Your institution 
should provide you with instructions to enable these should they be required.
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with a fixed-layout, neutral format for file exchange and publishing. Two popular 
fixed-layout, neutral formats are Adobe PDF and Microsoft PDF or XPS (XML 
Paper Specification).

To open a PDF file you must have a PDF reader on your computer such as 
Acrobat Reader, which is available for download from Adobe Systems.

To save a file as PDF:

1. Click the File tab  in Word.
2. Click Save As. The Save As Dialog Window opens (See Chapter 4). 
3. In the File Name Box, type a name for the file if it has not been saved before.
4. In the Save as type list, click PDF. See Figure 1-2a.
5. After choosing PDF other choices become available. See Figure 1-2b.

a. If the document requires high quality print, click Standard (publishing 
online and printing).

b. If file size is more important than print quality, click Minimum size 
(publishing online).

c. If you want the file to open in the selected format after saving, select the 
Open file after publishing check box.

6. Click Option button to set the page to be printed, to choose whether 
markup should be printed, and to select output options. Click OK when 
finished.

7. Click Save.

Compressing Files and Folders

Windows 7 comes with a compression utility that allows you to send or receive 
large or multiple files. Other programs that zip and unzip files include WinZip 
and StuffIt. Faculty may send textbook files in zip or compressed format to you 
as email attachments, place them on a file server, or post them to a CMS (Course 
Management System).

To compress a file:

1. Select the file or folder from your storage device or space.
2. Right-click the file or folder.
3. Choose Send To and then Compressed (Zipped) Folder. (See Figure 1-3.) 

A compressed folder  appears in the same place as the original folder.

NOTE: The procedure for saving a file in PDF format may vary depending on the program 
you are using. Some require you to select publish to or print print, and to change the 
printer to Adobe PDF. For more information, search Microsoft Office Help online for “Save 
as PDF or XPS format.”

Developing a Few Basic Skills 9
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Figure 1-2 “Save As Type” List for Saving a File as a PDF and 1-2b 
Choices When Saving a File as PDF
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To unzip a file:

1. Double-click the compressed file or folder (See Figure 1-4a). You may 
also right-click the compressed file or folder. Choose Open with, and then 
Compressed (Zipped) Folder or WinZip. See Figure 1-4b. Note that your 
window might look slightly different but will function similarly.

2. Select the appropriate file or folder to extract and then click the extract all 
files text. Again, a button may be available on a toolbar that you can use to 
extract files, depending on the program.

NOTE: Although you can view compressed files, they will not work properly until you 
extract them.

Communicating by email
The basics of technology-assisted communication such as email require a sender, 
channel, medium, and receiver, as illustrated in Figure 1-5. Both the sender and 
the receiver of an email message must have the appropriate hardware, software, 

Figure 1-3 Dialog Box for Compressing a File/Folder
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and a connection to the network if they are to communicate successfully. The 
sender creates the message, uses a specific application on a device, which codes 
the message for transmission across a channel. The channel includes equipment 
such as telephone wires, twisted pair, fiber-optic cables, radio waves, or satellites 
as well as the software that actually transmits the message to the decoder. You 
must connect the technology device to the communications channel by a modem, 
a router, a network card, or a wireless card in the computer. The computer that 
receives the message must then decode or translate the message back into a 

(a)

(b) (c)

Figure 1-4 Double Click Compressed File/Folder Window and 1-4b Right-Click Choices for 
Compressed File/Folder
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format that the receiver can understand. It is essential that both computers, as 
well as the channel, support the same communications protocol and standards if 
they are to “talk” to each other. For cell phones you use the same wireless connec-
tion for making and receiving calls but instead the phone connects to a cell tower 
and then the Internet.
 Obviously, most computers do not have a direct channel as seen in Figure 1-5, 
but rather send messages through a network. Most universities and hospitals 
are networked. A network consists of all computers and related devices con-
nected together for the purpose of sharing devices, programs, and data. Refer 
to Chapter 2 for additional information on networks and to Chapter 9 for addi-
tional information on the Internet. Chapter 10 discusses other forms of tech-
nology assisted communication.

Electronic Mail

Electronic mail (email) is a way to send messages to others in electronic form. 
Users write an email just like they would write a letter with word processing 
software. However, instead of printing the message and sending it via the postal 
system, email users typically click a Send button  in the email program. The 
email message arrives at its destination within a matter of seconds or minutes, 
depending on where it is going and the traffic on the network. Just as there are 
many different word processing, graphics, and spreadsheet programs, so there 
are many different email programs.

Sender Receiver

Coder

Decoder

Channel

Figure 1-5 Communication Model
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Many search sites and Internet service providers offer free email services. 
Table 1-1 outlines common functions shared by almost all email programs. 
Although this chapter provides general information about using email, it does not 
provide step-by-step procedures for using a specific program. For assistance in 
using your specific email system, check the help information online or the docu-
mentation for the system in your institution.

Email messages consist of two parts: the header and the body. The body is the 
actual message. The header has at least four (and sometimes five) sections that 
provide useful information:

■■ Date: This includes the date and time that the message was sent.
■■ From: This identifies the sender’s email address and, in many cases, the 
sender’s name.

■■ To: This identifies the receiver’s email address and can include the receiver’s 
name.

■■ CC: This optional section identifies the other people who will also receive 
a copy of the email message sent to the primary recipient. Most programs 
also provide an optional blind carbon copy (BCC). When you use the BCC 
function, a copy of the email is sent to one or more additional receivers; 
their names will not appear in the header and are not visible to the other 
receivers. Only the sender will know who has been sent a blind copy of the 
message. Using the BCC option also avoids sending an email with a large 
distribution list in the header.

■■ Subject: Use the subject line to convey the essence of the body of the email. 
This field will be blank if the sender omitted this information. Some univer-
sity email systems will not accept email if the subject field is blank. Always 
include one to three words in this section.

Email users are given a certain amount of space to store email messages on 
the server of their email provider. If you never delete email messages, eventually the  
allotted space will become full and the system will return all new messages. Thus 
people with email accounts should read their email often and delete messages that 
are no longer needed. By moving previously read messages to folders, the inbox of the 
email system remains uncluttered and new messages are more readily visible when 
you start the email program. In addition, some organizations have policies where they 
will automatically delete email sitting in the inbox, sent folder, or delete folder after a 
set time. Therefore, moving important email to folders will save it from deletion. It is 
possible, however, to occupy all of your allocated space with email messages that you 
have moved to folders. Most programs allow users to systematically store the mes-
sages that they wish to keep in folders off the mail server, either on the local drive or 
on another network server. Note that storing on the local drive means you won’t have 
access to those messages if you are not using that particular computer.
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TaBLe 1-1 COmmOn e-maIL FunCTIOnS

Function Description

Configure your 
e-mail settings.

When you set up your e-mail program you will make 
several decisions such as how you want your name 
displayed, your incoming and outgoing mail server 
name, and your password. Some of this information 
you will need to obtain from your internet service 
provider. 

Compose and send 
an e-mail message.

There are significant variations in the type of 
formatting available when composing an e-mail 
message. Some will permit all of the same text 
formatting available in your word processing package 
while others only accept plain text with no formatting. 

Reply to an e-mail. When replying to an e-mail check to see if you are 
replying to everyone who received the original e-mail 
or only the author of that e-mail message.

Forward an e-mail. Never send an e-mail you are not willing to have 
published. All e-mails can be forwarded to another 
person or even several people whom you may not 
intend to read your words. 

Maintain an address 
book.

This is a list of your contacts and their e-mail addresses. 
It is also possible to maintain distribution lists in your 
address book. 

Attach files to your 
message.

Any type of file can be attached to an e-mail message 
including word files, graphics, spreadsheets, audio, 
and even video. Remember the receiver will need the 
appropriate software to open these files. 

Create and attach 
a signature to your 
e-mail.

Your signature file includes your name and contact 
information that you want to share in your e-mails. 
This can be attached automatically to all of your 
e-mails. 

Organize and save 
your e-mail.

Most e-mail programs make it possible for you to 
create folders where you can categorize and save 
e-mails. For example you may want to save all of the 
e-mails related to a course in a folder with the name of 
the course.

Communicating by Email 15
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Email Addresses

All email systems provide users with individual addresses. On a local area net-
work (LAN), an email address operates much like an interoffice mail address; that 
is, the user’s local email address usually consists of the user’s ID only. In contrast, 
email sent over a wide area network (WAN) is like mail sent via the postal service, 
in that a full Internet address is needed. An “at” symbol (@) in an email address 
always separates the user ID from the rest of the address. There are three parts to 
an Internet email address. Suppose the address is janesmith@gmail.com.

■■ The user ID is the name of the individual on the computer system where 
one receives email. No one else on that system has the same user ID. The 
user’s ID in the previous example is janesmith.

■■ The “at” (@) symbol is always typed between the user’s ID and the user’s 
email system address.

■■ The user’s domain is the location address for everyone who uses that email 
system. This part of the address functions like the home address of a person 
in postal service mail delivery; that is, everyone in the same family uses the 
same apartment or house address. In the previous example, the location 
address is gmail.com.

One of the email application’s functions that is especially useful when sending a 
message to a group of people is the ability to create a distribution list (also called 
an alias or mailing list). The distribution ID is the assigned name to the list. Each 
time the sender addresses an email message using the distribution ID, each person 
on that list receives the message. For example, a list called ClassN402 might con-
tain the addresses of all students in a healthcare informatics class. When you send 
a message to the ClassN402 distribution address, the message arrives in the inbox 
of everyone on that list.

Email Related Terms

Attachment This is a file that accompanies an email message but is 
not in the body of the message itself.

Bounce  This is a message that failed to be delivered promptly. 
Emails can bounce for many reasons: For example, you 
typed the wrong email address, the recipient’s mailbox 
is full, the account no longer exists., (Email Experience 
Council, nd).

Emoticon This is a way to show an emotion via text on the com-
puter. These symbols or combinations of symbols sub-
stitute for facial expressions, body language, and voice 
inflections.
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Filter A tool that automatically moves incoming emails into 
separate folders according to criteria that either you or 
your Internet provider specified. Virus checkers or a 
software programs that you use may include filters. An 
example is the Junk Mail folder in Microsoft Outlook 
or the Spam folder on AOL.

Phishing Phishing is fraudulent email that solicits private infor-
mation such as passwords or credit card numbers. It 
can result in identify theft.

RSS (Really  This scheme makes it possible for you to subscribe
Simple Syndication) to and receive information about a specific topic that 

blogs, podcasts, and other social networking applica-
tions publish. Feeds deliver this aggregated informa-
tion, and you may read this content through a feed 
reader or email message.

Spam This is electronic junk mail. It is unsolicited and may 
or may not be from an identifiable source. It may be 
deceptive as well as being irritating and time wasting. 
Spam can lead to identity theft, disrupt your personal 
computer with malware, and turn your system into a 
zombie for distributing spam (FCC, 2011).

Spim This is the spam of instant messaging. It is part spam 
and part instant messaging that an increasing number 
of advertisers are using.

Email Etiquette (Netiquette)

Just as there are rules governing what is acceptable to say and do during social 
interactions, guidelines exist for acceptable ways of communicating using email. 
Many of these rules also apply to other forms of online communication. Neti-
quette is the name given to electronic communication conventions. Some of the 
main rules of netiquette include the following:

1. Start the message with a greeting, just like with any communication, and 
make it specific to the recipient(s): “Hi, Kurt,” “Mary,” or “Greetings, Col-
leagues.” With email, there is a tendency to be less formal than is common 
in a face-to-face communication. However, when dealing with faculty and 
medical personnel, it is better to use formal titles. It is also important to use 
the recipient’s correct title. For example, do not refer to a PhD-prepared 
professor or a physician as Mr. or Mrs.; use Dr. instead.

2. Include in the message only what is appropriate for others to read. Never 
assume the message is private.

Communicating by Email 17
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3. Be clear and concise. Email messages include only words. When people 
communicate face to face, they use intonation and body language as well 
as words to send the message. With email, no observation of the recipient 
is possible, so no immediate feedback or the ability to adjust the message 
midway is available. As a general rule, if one can misinterpret a message, 
it will be. “Emoticons,” like the smiley face, are available to signify feelings. 
Standard emoticons include the following:

:-) Basic smiley
;-) Winking smiley—means “just kidding”
:-( Sad face
8-) Smiley with sunglasses
-o : Surprised

There are several other emoticons, and several Web sites that list these 
symbols. As with all communication tools, the sender and recipient must 
understand the symbol for the symbol to be effective in supporting com-
munication. Consider text messaging abbreviations unacceptable in most 
email messages. For example, do not use the letter “U” to stand in for “you.”

4. Keep it short. Do not quote huge amounts of material. When replying, put 
the reply early in the message body so that readers do not have to wade 
through material to get to the response. If a longer message is necessary, 
attach a file with the message.

5. Always specify the content of the message in the subject line so that readers 
know what to expect. This information can also help readers discriminate 
between what might be a legitimate message from an acquaintance and 
what might be a message containing a virus.

6. Never type in all capital letters. THIS IS CONSIDERED SHOUTING.
7. Ensure that the message is well written. Check the spelling and grammar.
8. Respect copyright. Always give credit to others for their work, and follow 

copyright rules for using material (see Chapter 12 for guidelines as to 
copyright).

9. Avoid flaming, which is voicing very strong antagonistic opinions or ver-
bally attacking someone. Never respond when you are angry. It is hard to 
look professional or explain your thinking if you are in the middle of a 
“flaming war.”

 10. Sign the message. The signature should include at least the sender’s name 
and email address. It can also include the sender’s postal mail address, tele-
phone number, title, and professional affiliation. It is possible to create a 
“signature” file ahead of time and use it as a standard addition to all email.

 11. Do not send chain letters. A chain letter is an email that ends with the 
suggestion that the recipient forward the message to several other people. 
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One of the best ways to stop this type of junk email is not to forward it. 
If there is a specific email with a message you do want to share with a 
specific person, delete the part of the email suggesting you forward the 
email to others before you send it forward.  Keep in mind that when you 
receive an email that has been forwarded the email message may also 
have been edited or modified by anyone who had forwarded that email 
message.

Email Attachments

An attachment is a file sent along with an email message. You can send any type 
of file via email, including text files (Word files), graphics (PowerPoint files), 
spreadsheets (Excel files), audio (.wav files), and even video. Be certain that the 
recipient of the file has the appropriate software to open and run the file being 
sent. For example, if you send an Excel spreadsheet, the recipient will need to have 
the Excel software or a plug-in to access that document. Some email systems limit 
attachment sizes. If the receiver’s email system does not accept your attachment 
because it is too large, the system will bounce it back to you. Some email systems 
also do not accept files with certain extensions, such as .exe or .accdb.

To attach a file to an email:

1. Open the email program and look for words like compose mail, new mes-
sage, or a symbol . Clik the  words or symbol to start  and compose a 
message.

2. Once you have composed the message, look for a paper clip  or attach-
ment words. Click the words or paper clip.

3. Make appropriate choices in the window that appears asking for the loca-
tion and file to attach. Click Open on the appropriate file/document. Make 
sure the attachment (such as this: ) appears in the 
mail message window before you send the message.

Most email programs provide the ability to attach multiple attachments at once; 
however, most of these email applications also will limit the number of attach-
ments that you can include with one email message. Others like Microsoft Web 
Mail permit only one attachment at a time.

To download an email attachment:

1. Open the email program and display the mail message.
2. Look for words or a paper clip   that indicates an attachment. The attac-

ment should look similar to this: .
3. Double-click the file and click Save or click Open with…. (or something 

similar to those words).
4. Select a place to download the file.
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Each mail program is slightly different in terms of the location and display of the 
attached file. Nevertheless, all programs should give you the ability to right-click 
and save the file to a specific location. Typically, clicking the attachment indi-
cator either opens the file or opens a dialog box that allows the viewer to save the 
attachment to a file or to open the attachment. Sometimes you will need to right-
click to see these options.

Safe Email Practices

To protect the computer, it is wise not to open attachments without checking 
them for a virus. Most virus-checking software will give you the option for con-
figuring your virus checker so that it scans all attachments automatically as they 
come into your email program. However, no virus checker will catch every virus. 
Malicious computer hackers have developed systems that enable them to access a 
user’s address file and send messages to everyone in the list, making it appear as if 
the message is from that user. Thus it is prudent not to open attachments unless 
you expect them. It is also wise to configure your virus software to scan email 
attachments before you open them if you do not configure your virus-checker 
to do so automatically. While all attachments can include malicious applications, 
executable (.exe) attachments are highly suspect. Once you open an infected file, 
these attachments may create a variety of problems on the computer.

While most university systems routinely check all attachments before deliv-
ering the email to the individual user, new viruses can slip through this safety net. 
Therefore, the safest course of action is to save the attachment to a folder—just 
be sure to note in which folder you are saving the file—and then explicitly check 
it with an antivirus program such as BitDefender, Norton Utilities, or Webroot 
SecureAnywhere Antivirus software before opening the file. If the antivirus pro-
gram finds a file with a virus, delete the file from both your email list and the 
computer’s delete folder without opening it.

Today, at least 77% of the U.S. population has Internet access in the home, 
and email has become a primary tool for communication, sometimes rivaling 
even the telephone (ITU, 2012). The percent goes up when you talk about other 
Internet access through schools, libraries, and work. Along with its advantages, 
however, has come the irritating problem of unsolicited messages—that is, spam. 
Many Internet providers offer spam-blocking products for their customers, and 
some email programs have filters that you may set to block spam related to speci-
fied subjects or from specified addresses. It is wise to never open messages from 
anyone or any company that you do not know. Never respond to spam because 
this reply can confirm that your email address is active and you are reading these 
emails. Always report spam to your Internet service provider. Most ISPs that pro-
vide email functionality make sending such reports easy, through an option on 

20 ChapTer 1: On The Way to Computer and Information Literacy 

ch01.indd   20 5/13/2013   3:03:07 PM

© Jones & Bartlett Learning, LLC. NOT FOR SALE OR DISTRIBUTION



the email menu. In an attempt to prevent advertising spam from coming into 
email accounts, some individuals set up a separate account for electronic discus-
sion groups, ordering online, and registering warranties to control the number of 
advertisements coming to their personal email account.

No matter what address appears on an email or which trademarks appear on 
the email, you should never provide personal information such as your password, 
account number, or Social Security number in response to an email message. 
Some emails fraudulently represent commercial companies by including the com-
pany’s headers or logos on the email message and then request personal infor-
mation. Your bank and any other company that you do business with will never 
request this type of information by email.

These so-called phishing scams can lead to identity theft. A common phishing 
scam on campus is to send emails offering part-time work. The email will look 
like it is coming from a campus email address. However, when students apply for 
the job by providing their personal information, including their Social Security 
number, they have just been caught in a phishing scam. If you receive such an 
email job offer, call the university’s human resources department by phone and 
ask if the message is legitimate.

While email is a frequently used Internet tool, another tool that comes with 
Microsoft Office and that is less frequently used is OneNote. This tool has many 
capabilities that you need to exploit and that can assist you in gathering informa-
tion as you use the Internet.

using Onenote
Microsoft Office OneNote 2010 provides you with an electronic tool for creating, 
gathering, organizing, storing, and sharing information such as notes from class, 
reference materials, and Internet sources. You gather information in digital note-
books that are equivalent to traditional three-ring binders, where each notebook 
has sections and pages. You can store almost any kind of electronic informa-
tion in OneNote, such as photos, text, graphics, audio, Web clippings, and video 
clips. You can write a note with the keyboard, write a note with a “pen,” or copy 
something from the screen and paste it into OneNote or even into another Office 
document. When you copy something from the Internet, the OneNote page will 
automatically display the URL from the source site. Collaborative tools help you 
work with others in shared notebooks both offline and online. The program 
highlights unread notes and notes the author in shared notebooks. You can link 
Notes to Word or PowerPoint documents. OneNote also supports touch-enabled 
operating systems. If you sync your notebooks to SkyDrive they are available any-
where from any computer. We captured some of the small figures or icons in this 
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text using OneNote. OneNote in Office 2010 now uses tabbed ribbons like other 
Office applications.

OneNote Basics

OneNote in Office 2010 comes with one preset notebook called Personal. 
Figure 1-6 shows the window that appears when you open OneNote for the first 
time. Under the General Section the first page provides a summary of OneNote. 
On the right, under New Page , is a list of all pages in this section. These 
pages describe what’s new in OneNote, what it does, its top uses, and the basics of 
use. To explore this guide, click each page tab and read its contents to get an idea of 
how OneNote works. You can expand or collapse Page tabs by clicking the chevron 

 to the right of New Page. There are also up and down chevrons on the Naviga-
tion pane that expand and collapse the view of each notebook as Figure 1-6 shows. 

Figure 1-6 OneNote Window with Description of Uses for Home, Work, and School

One Note Basics

Page Tab SelectedRibbonPersonal Notebook

Top Uses

What’s New

Personal Notebook Contents expanded by clicking the Chevron.

Navigation Pane
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Figures 1-7a and b shows the material provided in OneNote Basics. Figure 1-8a, 
b, and c provides a partial list of what is in the Top Uses page. You will also find it 
worthwhile to review the online training available from Microsoft for OneNote. 
Click Help  in the menu bar and choose Microsoft Office Online to discover 
the options available. You can also choose Help under the File tab.

Figure 1-7 OneNote Basics
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Working with OneNote’s Tabbed Ribbon

OneNote 2010 now uses a tabbed ribbon just like other Microsoft applications to 
hold commands instead of toolbars. Figure 1-9 shows the individual tabs in One-
Note’s Ribbon when you select them. 

As with other Office applications, the File  tab offers a backstage view 
of all the things you do with a document such as opening, saving, printing, and 
so forth. Figure 1-10 shows the File tab with Info selected. This shows the list of 
notebooks in OneNote (in this example Personal and Research) as well as ways to 
access other notebooks. Figure 1-11 gives the choices available as to where to find 
a notebook when you select the Open command. 

Figure 1-12 shows the New command that offers choices for storing, naming, 
and creating a notebook. The Share command provides choices for posting a 
notebook to the Web or network. See Figure 1-13. The Save As command, shown 
in Figure 1-14, lets you select a format (Word, PDF, etc.) for saving your page, 
section, or notebook. Figure 1-15 shows the choices available when you choose 
Send or Print. Figure 1-16 lists the Help options you can explore as well the 
choices available under Options for customizing your display, mini-toolbar, 

Figure 1-7 (Continued)
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Figure 1-8a Top Uses of OneNote (A partial list)

ribbon, audio, and video among others. Figure 1-16 shows the General option 
choices. On the right side of the OneNote window is an arrow. If the arrow looks 
like this  the ribbon is not expanded and you won’t see the contents of each tab 
as they appear in Figure 1-9. Click the arrow and it turns into this ; the ribbons 
expand so that when you click a tab the ribbons look like they do in Figure 1-9.

Using OneNote 25

ch01.indd   25 5/13/2013   3:03:08 PM

© Jones & Bartlett Learning, LLC. NOT FOR SALE OR DISTRIBUTION



Figure 1-8b (Continued)

Using OneNote

When you open OneNote for the first time, you will see a window like that shown 
in Figure 1-17—an untitled new page. You can click anywhere inside the page and 
write a note, draw something, or paste text or a picture. The note will appear in a 
“container” or text box like this:  with the cursor inside. You can modify 
the container using traditional Microsoft protocols. If you don’t see the Untitled 
Note Page, click the New Page button  (see Figure 1-17).
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To move the container:

■■ Click the container and the cursor changes to a four headed arrow .
■■ Drag the container anywhere on the page.

To size the container:

■■ Click the container edge and the cursor changes to a two-headed arrow .
■■ Drag the edge to change the width of the container.

Figure 1-8c (Continued)
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Figure 1-9 Tabs in OneNote
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To remove what you typed:

■■ Select the text.
■■ Press the Backspace or Delete key. Alternatively, you can right-click and 
choose Cut from the menu that appears.

Figure 1-10 File Tab in OneNote—Info Selected

Figure 1-11 Open Command under File
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Creating a new notebook, Section, or page
You can create a new Notebook and then add new pages and sections to the 
notebook.

To create a new notebook:

■■ Click File .
■■ Click New ; a menu will appear as shown in Figure 1-12.
■■ Select a storage space—Web, Network, or My Computer.
■■ Type a name for the notebook.
■■ Select a location (type it in or click browse button) and click create 

notebook.
■■ In addition to the 2010 templates, templates from OneNote 2007 are avail-
able online that deal with house hunting, research, job applications, school, 
and work, for example. Each notebook can have several sections. You can 
add new notebooks at any time.

Figure 1-12 New Command under File Tab
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To add a new section to a notebook:

■■ Click the starburst icon  in the far right mini-tab.
■■ Select the text on the new section tab.
■■ Type a name for the section. 

To add a new page:

■■ Open the Notebook or section where you want to insert the page.
■■ Click New Page  in the page tabs list on the far right. The Page task pane 
lists any untitled or named note pages. You can also click the arrow next to 

Figure 1-13 Share Command under File
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Figure 1-14 Save As Command under File

Figure 1-15 Send and Print Commands under File
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New Page and a popup menu appears (see Figure 1-18 for options).You can 
also choose a template.

■■ Click the placeholder and type a name for the page . 
■■ You are now ready to add Notes to the page. Click on the page and add the 

note to the container that appears.

Figure 1-16 Help and Options Commands under File
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Once you select a new page, you can alter the page setup to meet your needs. 
For example, you can change the font, add rule lines, make a list, use bullets or 
numbers, and check spelling. If you choose the Draw Tab (see Figure 1-9) you can 
select from a variety of pen colors and widths. If you have a pen or stylus tablet  
PC you can just draw. Otherwise hold down the mouse button after selecting a 
pen tool and draw. If you make a mistake, click the Eraser button  and choose 
from the drop down menu whether you want a small, medium, large, or stroke 
eraser. You can resize each image or move it around the page in the same way 
that you can move other containers. Remember that you can add notes and sec-
tions to a notebook at any time. You can easily move unfiled notes to sections or 
notebooks. However, it is wise to consider the type of tasks and the type organiza-
tional structure works best for the content. Also note that OneNote automatically 
saves notes and notebooks.

Capturing Screen Clippings

You can use the OneNote Screen Clipper to copy an image of anything you see on 
your computer screen.

To capture a picture, icon, or piece of text on your screen:

■■ Press the Windows  logo key + S. The screen changes to a filmy white 
and the cursor changes to a plus sign.

■■ Place the plus sign over a corner of the object/picture you wish to copy; click 
and drag until you have selected the image you desire. Release the mouse 
button.

Quick Access Tool Bar

Navigation Pane Program Window Pages

Sections New Page Button

Figure 1-17 Untitled New Page 
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Figure 1-18  
New Page 
Choices and 
Templates
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■■ A menu box appears asking you where you want to store the image (see 
Figure 1-19).

■■ Select a destination from the list and click Send to Select Location 
 button.

■■ The image will appear on a Notes page, along with the date and time when 
you clipped it.

Here is another way to prepare to take a screen clipping:

■■ Click the Insert tab in OneNote.
■■ Choose Screen Clipping ; the screen turns white and you proceed the 
same way.

Figure 1-19 Menu Box for Selecting a Storage Place for a Screen Clipping
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To capture an image from a Web page:

■■ Go to the Web page and locate the image to capture.
■■ Switch to OneNote, select the page to place the image, and click where you 

want the image to go in OneNote.
■■ Click Insert tab, Screen Clipping in the images group. OneNote minimizes 
and you see a dimmed Web page.

■■ Click and drag to select the image. When you release the mouse button, 
OneNote captures the image and inserts the image in the location you 
selected.

When you capture an image from the Internet, you can also display the 

Internet address. Choose Link  from the Insert tab, type a title for the image, 

and copy the Internet address to the provided box. See Figure 1-20. When you

Figure 1-20 Link Menu Box
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 return to that page you can hold the cursor over the title of the image and the 
internet address where the image came from will appear as shown in Figure 1-21.

Copying Text or Images to Other Documents

Once you capture an image, OneNote also places it on the Windows Clipboard. 
This provides you with the ability to paste the image to other documents. You can 
now paste that image into other documents such as Word or PowerPoint. If you 
are now reviewing your notes in OneNote and decide to copy several images cap-
tured previously, follow these directions:

To copy an image or text from OneNote and paste it into another document:

1. When you place your mouse arrow over the image/text, it turns into a four-
headed arrow  . Click to select the text.

2. You have several ways to copy it:
a. Under the Home tab, choose Copy, or
b. Right-click the image and select Copy  on the short cut menu, or
c. Click the Copy  icon in the Quick Access toolbar if it is present, or
d. Press Ctrl+C.

Figure 1-21 Screen Clipping with Link to Web Page
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3. Go to the document where you want to place the image:
a. Choose Paste under the Home tab, or
b. Right-click the image and select Paste on the short cut 

menu, or
c. Click the Paste icon  on the Quick Access Toolbar if present, or
d. Press Ctrl+V.

NOTE: If you don’t have the Copy and Paste icons on the Quick Access Toolbar, go to 
the down arrow  in it and click it to bring up the menu for customizing the Toolbar. 

Working with Side Note

Side Note is a small version of OneNote and functions much like a sticky note. It 
appears in its own small window. It will stay open on your desktop when you click 
the dock to desktop icon  as shown in Figure 1-22. Use Side Note to make notes 
when you are working in other programs. The ribbon is a smaller version of the 
one on OneNote with tabs containing many of the same choices. OneNote auto-
matically saves Side Note in the Side Notes section of your notebook.

Copy part of screen into OneNote as an Image

Dock to Desktop Full Page View

Record Audio

Record Video

Figure 1-22 Side Note Ribbon with Home Tab Selected
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To open a Side Note window and add notes:

1. Press the Windows logo  key + N or right-click the OneNote icon in 
the notification area of the taskbar and click Open New Side Note.

2. Click in the blank area of the OneNote and type your message. OneNote 
saves this Side Note in the open notebook.

To create a Linked Note:

1. If you are using Word or PowerPoint and want to make quick notes about 
something to remember later, select Linked Notes  under the Review 
Tab in Word or PowerPoint.

2. Select the location for the Side Note and click OK. This will associate the 
notes with the application.

3. Type the side note.

Moving Pages, Sections, and Notebooks

Moving large pieces of information is easy in OneNote. The following are some 
ways you can do this. Be aware that the target notebook must be open to move 
content to it.

To move This Do This

A page or subpage within 
a section

Drag the page tab up or down on the page task pane.

A page to another 
notebook

Drag the page tab to the desired section in the notebook.

A section within a 
notebook

Drag the section tab left or right in the notebook header; or
Drag the section tab to the desired location in the Navigation Pane; or
Right-click the section tab and then click Move. In the Move or Copy 
Section dialog box, click the location where you want the section to go, 
and then click Move or Copy .

A section to another 
notebook

Drag the section tab to a new location in the Navigation Pane; or 
Right-click the section tab and then click Move. In the Move or Copy 
Section dialog box, click the location where you want the section to go, 
and then click Move or Copy.

A notebook on the 
Navigation Pane

Drag the notebook title up or down the notebook list.
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Other Features

A few other features that are important include sending information to other 
Office programs, tagging notes, sending an image or text from a browser, and 
search OneNote. Tags mark notes for easier 
return to that reminder, for follow-up, and to 
send to others. Tags also let you set priorities 
and categorize your notes.

Sending a piece of information, a table, or 
picture to another Office Program:

1. Select the pages or section you want to 
send.

2. Go to File and click Send. Choose 
one of the listed options as shown in 
Figure  1-15.

Tagging notes:

1. Select a note to tag.
2. Find the Tag Box  on the Home 

Ribbon. 
3. Click the Important Tag. A star  will 

appear in the note’s container.

If you click the down arrow , a menu 
appears as shown in Figure 1-23. Many more 
choices become available on this menu.

Sending a note or image from a browser 
to OneNote:

If you are working in Internet Explorer 
or Firefox, you can send an image or text to 
OneNote. Chrome requires the installation of 
an extension.

1. Find an image or portion of text or 
even the whole Web page.

2. Press the Windows logo  key + S.
3. Drag the mouse over the section/pic-

ture you wish to capture.
4. Double click the section/page in the 

OneNote menu where you want to 
send the image. See Figure 1-24.

Figure 1-23 Drop Down 
Menu for Tags in OneNote
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Searching Onenote
This section has highlighted just a few of the many things you can do with One-
Note. If you use this program properly, you will end up with a large collection of 
information. Even if you use all the tools possible to organize your information, 
you may need to search for some information.

1. Go to the Search text box  and click in it.
2. Type the word(s) that represent the information for which you are 

searching.
3. Click the magnifying glass .
4. A list of the matches appears, highlighted in yellow. Click View List, and a 

partial description of each match appears on the right side of the window.

Figure 1-24 Location Selection Menu in OneNote for Screen 
Clipping
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additional Tips
Some additional tips described here will prove helpful as you work through this 
text to develop your technology literacy skills.

1. Do not try to complete all of the text exercises at once. Sometimes it is 
helpful to come back later, especially when the exercises are not going well 
or when fatigue sets in.

2. Pay attention to messages on the screen. They are the computer’s way of 
trying to provide help.

3. Use the software sequences at the end of each lesson on an application pro-
gram to complete the exercises or assignments for that software program. It 
is not necessary to memorize the commands, mouse clicks, or sequences of 
events. Use the screen clues, prompts, and online help to guide you through 
the sequence.

4. Explore additional functions by referring to other reference sources such 
as online help, manuals, or reference books. We’ve chosen the functions 
highlighted in this book to help you complete the exercises and learn some 
basics of how the programs work. Many more functions are available within 
each of the software programs presented here.

5. Always back up your files. This point is especially important for the 
beginner so that you will not lose hours of work. Open a document and 
then save it immediately; don’t wait until you have finished it or finished 
your session on the computer.

6. Practice doing assignments from all courses using your computer. It takes 
practice to develop computer literacy. The more you use the computer, the 
easier and faster tasks will become.

7. Be patient. Learning a new vocabulary and developing new skills take time 
and energy.

8. Start collecting information for your e-portfolio using OneNote.

Summary
This chapter provided an introduction to computer and information literacy. It 
described how this book is organized and the conventions used to denote user 
actions.  The chapter presented  helpful information about getting started using 
the school or laboratory facilities. Instructions related to creating a PDF file and 
compressing files are included.  The chapter addressed the essentials of email com-
munication. Also described were the basics of using OneNote—getting started, 
opening new notebooks, adding pages or sections, using the drawing tools, and 
taking screen clippings. Finally, it described resources for learning more about 
OneNote.
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exercises   

exerCISe 1 Using an Email System

 ■ Objectives
1. Access an email system.
2. Change the password for an email account.
3. Read, save, and delete email.

 ■ Activity
1. If you do not already have an email account, obtain an account from the 

university computer center. An account gives you permission to use the 
system. This permission comes in the form of a user ID and a unique 
password. If you were not provided with an account, you need to set up 
a computer account before doing this exercise. If you have a user ID and 
password, you are ready to begin this exercise. If your university does not 
provide email accounts, use an Internet search engine to find one of the free 
online services that provide email accounts.

2. Find the documentation. Most institutions have documentation for com-
puter programs available to users. Short handouts are usually available for 
free either in print or at the institution’s Web site. Find out where and how 
you can obtain documentation in your institution. Obtain a copy of  or view 
the documentation for signing on to the system and for using email. With 
an account, you may also be able to access online help.

3. Sign on to the network. Follow the directions for signing on to the com-
puter system. Typically, you will type the user ID, and press the Tab key to 
go to the next text field. Type the password, and then either press Enter or 
click OK.

Remember that the password will not appear on the screen. In most 
email programs, it appears as a series of asterisks (******) or black dots in 
the Password text box.

If a message appears on the screen saying Invalid password, Login 
incorrect, or something similar, try typing the user ID and password again. 
Some systems are case sensitive; thus you need to note whether you should 
or should not use capitals in either the user ID or the password. Most sys-
tems give you at least three tries to get in before the account is locked out; 
you will then need to see the account administrator or call the Help Desk to 
have it unlocked.
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4. Change the password. When signing on for the first time, most email sys-
tems require you to change the password before proceeding. If the system 
does not require you to change the password, this should be your first 
action after signing on. Check the documentation for the specific process 
for changing a password.

In email programs:
a. Click the Password icon, or select an option on a menu, or click a hyper-

text link.
b. When prompted for the current password, type the current password, 

and then either press Enter or click OK.
c. When prompted, type the new password, and either press Enter or click 

OK.
d. When prompted, type the new password a second time and either press 

Enter or click OK.
When you are typing passwords throughout this procedure, the pass-

words will not appear on the screen. The change is usually processed 
immediately, although on some systems, there may be a time lag before 
the new password takes effect. Check the system documentation. Also note 
that many universities have a one login system. Once you change the net-
work password, your email password also changes; other places require you 
to login to the network and then the email program.

5. Access the email system. This may be as simple as selecting MS Outlook 
from the programs list on the Start menu of the desktop or clicking an 
email link to another email program like gmail. You may also be able to 
type the URL for the email program directly in your browser. For example, 
mail.yahoo.com/. For personal emails, you may need to use a browser to 
access an email program like gmail or yahoo.

6. Once you login to your email, open and read each message.
a. Double-click or highlight the email message, and press Enter.
b. If this approach does not work, look at the screen for directions, and 

read the written documentation for the system. After you read each 
email message, look at how the email directory changed.

7. Send a message. Find the email address of a friend. Asking the friend for 
his or her address is the easiest way to do this. In college settings, there may 
be a faculty, staff, and student directory online address book that contains 
listings of addresses. One way to test your understanding of the correct pro-
cedure at the location is to practice by sending yourself a message. Once 
you master the procedure, practice sending messages to a friend.
a. Start the email program.
b. Type the email address of the friend in the To text box. Many programs 

permit you to select the address from the email address book by double-
clicking it.
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c. Press the Tab key or click in the Subject text box.
d. Type in the subject, and press the Tab key or click in the Message text 

box. Most likely you do not need to CC yourself. Most email programs 
automatically place a copy of all email sent out in your Sent folder.

e. Type and format the message.
f. Click the Send icon.

The procedure for composing an email message varies greatly from one 
system to another. The previous information outlines the general process 
used by many of today’s email programs. If this procedure does not work, 
read the local documentation for the following information:

How do you initiate the function to compose a message?
How do you enter the address of the person who will receive this message?
How do you enter the email message?
When the email message is ready, how do you give the send command?

8. Reply to a message.
a. Open an email message (double-click it).
b. Click the Reply to Sender  icon. This symbol may look different for 

different programs. The program inserts the sender’s address and subject 
in the appropriate text boxes. The Subject text box uses the same subject 
and adds the prefix “RE:” to it. Note the difference in the option Reply to 
All versus simply Reply.

c. If you receive a message as part of a distribution list, find out how to 
reply to the author and how to reply to everyone on the list.

d. Compose the response, and click the Send button.
9. Save or delete each message.

a. Highlight the message.
b. Press the Delete key or click the Delete button. In some Web-based 

email programs, you delete messages by clicking in the square box next 
to the message, and then clicking the Delete button. 
Read the local documentation for the delete procedure. In many email 

applications, you must “empty the trash” or “purge the Delete folder” to 
remove a message. Once you complete this step, you will not be able to recover 
deleted messages. If you do not delete messages, the mailbox will become full 
and eventually new messages will bounce back to the sender. Most email 
programs automatically save a copy of all sent messages in a Sent folder. If 
these sent messages are left to accumulate, this folder will eventually take up 
too much space and new email sent to this mailbox will bounce. The system 
administrator may also automatically empty the sent message folder after a 
set time period. Some email programs leave the undeleted messages in the 
inbox, whereas others move them to an older message folder. You will know 
the message is in the inbox if the message is listed in the message list each time 
you start the email program.
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c. Read the local documentation for the save procedure. Most systems 
permit you to move messages into online folders. Read the documenta-
tion for a procedure for saving messages in folders.

 10. Exit the email program.
In Windows-based email programs, follow one of these procedures:

a. Click the Close button  in the upper-right corner of the screen.
b. Alternatively, select File, Exit from the menu bar.

It is important to exit the email system with the computer still run-
ning. If you turn the computer off or just walk away without exiting email, 
someone else may be able to access your account without signing on. Once 
you exit the email program, complete the computer sequence for shutting 
down the computer as specified by the laboratory, library, or other locale.

exerCISe 2 Log In, Download, and Send an Email Attachment

 ■ Objectives
1. Log in to the email program.
2. Download and send an email attachment.

 ■ Activity
1. Log in to the mail program you will be using for this course. You will 

receive an email with an attachment from your professor.
2. Open the email and follow the instructions contained in it. It will contain 

a compressed file. Download the compressed file using the directions pro-
vided in this chapter. Extract the contents of the file. What was in the com-
pressed file?

3. Send an email to your classmates and professor that contains the following 
information:
a. A brief introduction of you, your interests, and so on.
b. An attached picture of you attached to the email.

4. Read and respond to your classmates’ emails. Open their attachments.

exerCISe 3 Information Literacy Competency Standards for Higher Education 

 ■ Objectives
1. Develop a personal definition of information literacy.
2. Add the definition to OneNote.
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 ■ Activity
1. Go to the Web site of the Association of College and Research Libraries.

a. Type http://www.ala.org/ala/mgrps/divs/acrl/index.cfm.
b. Click Guidelines and Standards on the left side of the screen.
c. Move down the list and click Information Literacy Competency Stan-

dards for Higher Education (Jan. 2000).
d. Review the standards by selecting Standards, Performance Indicators, 

and Outcomes.
e. Review the material on information literacy and information technology 

at this site.
2. From this material, develop your own definition of information literacy.
3. Place this definition in OneNote for later addition to your e-portfolio. Keep 

a weekly journal of the skills you are developing in this course.

exerCISe 4 Electronic Reference Formats

 ■ Objectives
1. Find sources for styling electronic references.
2. Recognize the appropriate format for electronic references used by the 

American Psychological Association (APA).

 ■ Activity
Use OneNote to keep a notebook of your findings regarding how to format 
electronic references. If necessary, review the processes described earlier in this 
chapter. In the Word chapter, you will learn how to use templates and the Refer-
ences tab to automatically format your papers and references in the correct style.

1. Go to the Dartmouth Institute for Writing and Rhetoric.
a. Type http://www.dartmouth.edu/~writing/.
b. Click Sources & Citation at Dartmouth.
c. Download a copy and review it. (Note: You will need the PDF add-in 

utility on your computer. If necessary, review the process for adding the 
PDF utility that was described earlier in this chapter.)

2. Go to APA Style.org.
a. Type http://www.apastyle.org/.
b. Click Websites.
c. Review the page.

3. Review the following sources:
a. Type http://www.dianahacker.com/resdoc/.

 i. Hold the mouse pointer over Finding Sources in the Sciences Section 
and click Nursing and health.

 ii. Review the sections on Databases and Indexes and Web resources.
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b. Go to “The Owl at Purdue” and review its APA Formatting and Style 
Guide.
 i. Type http://owl.english.purdue.edu/owl/resource/560/01/.
 ii. Under General Format, scroll down and choose Reference List: Elec-

tronic Sources.
 iii. Review the materials.

exerCISe 5 Compare Three Information Literacy Tutorials

 ■ Objectives
1. Review three different information literacy tutorial series.
2. Compare and evaluate them.
3. Use OneNote to write your comparison.

 ■ Activity
1. Compare the following three information literacy tutorial series in terms 

of their ease of use, ease of navigation (i.e., ability to move around them), 
content, and value to you.
a. Information Literacy Tutorial: University of Wisconsin-Parkside Library

 i. Type http://www.uwp.edu/departments/library/. 
 ii. Under Quick Links, click Information Literacy. 
 iii. Click Start the Tutorial under Quick Links.
 iv. Select Module 5. Review any other modules that are of interest to 

you.
b. Information Literacy Tutorial: University of Wisconsin-Milwaukee

 i. Type http://guides.library.uwm.edu/infolit.
 ii. Review the six modules—especially Module 6.

c. Information Literacy Video Tutorials: University of Pittsburgh
 i. Type http://www.library.pitt.edu/services/classes/infoliteracy 

/teaching.html.
 ii. View Avoiding Plagiarism and Surfing the Cyber Library. View any 

other videos of interest to you.
2. Add a new notebook to OneNote Titled Chap1-Ex4-YourName. Create a 

new page in the notebook titled InfLitComparison. Add your comparison 
to the new page.

exerCISe 6 Explore the Uses of e-Portfolios

 ■ Objectives
1. Describe the essentials of an e-portfolio.
2. Describe the relationship between information literacy and e-portfolios.
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 ■ Activity
1. Go to the e-portfolio site at Penn State.

a. Type http://portfolio.psu.edu/.
b. Click the Featured Portfolio and view the video.

2. What is an e-portfolio?
3. How does it relate to information literacy?
4. Next click Featured Resource. Review the page and check out other links 

such as Information Literacy, Copyright, and Plagiarism Prevention 
Resources.

5. If you are interested in learning more about e-portfolios, you will find an 
Overview of E-Portfolios by the Educause Learning Initiative at this site: 
http://net.educause.edu/ir/library/pdf/eli3001.pdf.

assignments

aSSIGnmenT 1 Learning about Your School’s Computer Policies

 ■ Directions
Use your school’s intranet site to find the answers to the following questions:
 1. Find your school’s Web site. What is its Uniform Resource Locator (URL)?
 2. Is there a technical support center? Is it known by another name?
 3. What are the policies and procedures of the academic computing center?
 4. Can you download these policies?
 5. How does a student set up network and email accounts?
 6. Which operating systems and software does the center support?
 7. Is there a laptop or mobile device lease/buy program at your school?
 8. Does your school have an e-portfolio system for students?
 9. Is there an e-learning center? If so, which classes are available?
 10. What are the hours for technical support?
 11. What was the most valuable thing you learned from this assignment?
 12. Write a summary of your learning from answering these questions. Save 

the file as Chap1-Assign1-YourName. Submit the file as directed by your 
professor.

aSSIGnmenT 2 Setting up an Online Email Account

 ■ Directions
1. Use an Internet search engine to find a free email application. 
2. Select a free email application from one found.
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3. Click the new user sign-in link, and follow the instructions given. Read all 
of the privacy information. When given the choice, be sure that you select 
the free email service. How much storage space do you get for your email in 
this system?

3. Once you register, read the welcome message. How often do you need to 
use this system for your account to remain active?

4. Print this message to hand in, and answer the previous questions on the 
printout.
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